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by Digital Dave
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Selling Stuff on the Web
by Jack Dunning

All You Need Is a Shopping Cart!
There is no need to reinvent the wheel. There are many options for starting your own Web business.
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by Jack Dunning
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Digital Dave

“Digital Dave answers your tech questions.” by Digital Dave

|

Google Chrome Homepage Problem; Windows XP Reinstall and Activation.

Google Chrome

Dear Digital Dave,

I have a Toshiba laptop with Windows Vista OS. It appears that Internet Explorer is full of
bugs so I tried going to Google Chrome. Now when I open Chrome I get a couple of ads to
speed up my computer or upgrade to a better version of Chrome. Have I downloaded a virus
along with Chrome?

Thanks for all the help in the past. We here in San Diego are so lucky to have had a
magazine as ComputorEdge start here even though the name was changed.

Mike

Spring Valley, CA

Dear Mike,

You don't necessarily have a virus. It may be that your home page (the first page to load when
you open Chrome) has been hijacked. Open "Customize and control Google Chrome" by
clicking the icon (three little horizontal lines) in the upper right-hand corner and select Settings.
In the category "On startup" you have various options for resetting the home page from just
opening a new tab to setting a number of pages. Set startup the way you want it.

If you find that your home page is continuing to be hijacked then you may have an extension
(add-on) that's causing the problem. Open Tools => Extensions in the same menu and disable
or remove any add-ons that look like they could be the culprit. You will probably need to reset
your "On startup" pages again.

If the problem returns again, then there may be an installed program causing the problem and
reinstalling/enabling the extension in Chrome. Go to "Programs and Features" (either through
the Control Panel or the Search field in the Start Menu) and look for a program which may be
causing a problem. If you're not sure about a program, do a Google search. Often the program
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will have a name similar to the culprit extension. Uninstall the program, remove the extension,
and reset the startup pages.

Normally, this will resolve the issue, but if it still comes back, then by now you should have
the name of the malicious adware. Look it up on the Web and you should be able to find more
detailed instructions for removing Registry entries and Startup items.

Digital Dave

Windows XP Reinstall

Dear Digital Dave,

After a recent hard drive failure, I reinstalled my OEM version of Windows XP on a new
hard drive. When I tried to activate it, activation failed and I got the message, "cannot
connect to server." Is this an "end of life" issue or is something else amiss?

Dennis

San Diego, CA

Dear Dennis,

It should not be an end-of-life issue for Windows XP. Microsoft has said that it will continue
to support activation for Windows XP. However, as I understand it, there is a built in limit on
the number of Internet activations before you need to use phone activation.

But first make sure you have all the appropriate drivers for Internet access. If you know that
you have Internet access, there should be an option to get a phone number when you go
through the activation process. Call that number. It should work since it is an automated
system. Let me know if it doesn't. It was difficult to get a reliable answer for the question of
support for phone activation for Windows XP. If Microsoft ever drops its activation service
for XP, they say they will also drop the need for activation rather than make XP unusable.

Digital Dave
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Selling Stuff on the Web

“All You Need Is a Shopping Cart!” by Jack Dunning

There is no need to reinvent the wheel. There are many options for starting your own Web business.

Starting your own business is the American dream. There is nothing like the independence of
running your own company—especially if you're making money. No more kowtowing to the
whims of a capricious boss who makes changes for the sake of making changes. Integral to
our national culture is the liberty to do the things we want to do when we want to do them.
Building a business out of nothing is a concept woven into our fabric.

It's risky to start a new company. It can be expensive, and, if it doesn't work out, you could be
left dead broke. However with today's new technology, there are ways to minimize risk while
venturing into new arenas. It's possible to test commercial projects without over investing. It
isn't free and does take a good bit of sweat equity (your labor), but there is no need to risk
your entire future while starting a new enterprise. Business is about selling and one of the best
(and cheapest) ways to sell is on the Web.

If you're just cleaning out your garage or unloading some old DVDs, you may want to sell
them on eBay or Amazon. They are both huge names in Web e-tailing and cater to individuals
as well as businesses. If you want to go into the business of selling products over the Internet,
then these same companies provide a huge market and selling tools for a percentage of the
take. Many business people operate almost exclusively with eBay and/or Amazon. However, if
you want to go it alone and build a core business which you totally control, then you may want
to set up your own Web page to sell your products.

For example, the 3D printer has generated many new opportunities for budding inventors. The
price of a 3D printer is low enough that almost anyone can set up to sell newly printed
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products. (The product ideas are up to you.) But, even if you have the genius to develop new
innovative pieces, you still face the problem of displaying and selling your work. You need an
online catalogue and a way to get paid. Fortunately, you can get your Web catalogue and
payment solution for a relatively low price ($50-$60 per month) in the form of a Web
shopping cart.

The Web Shopping Cart

The purpose of Web shopping cart software is to offer a Web site which acts as a catalogue
and selling system. While it is possible for an experienced programmer to build their own e-
commerce site from scratch, there is little motivation to do so. There are so many service
providers offering everything needed to set up a Web retailing site at a reasonable price that it
would be foolish to incur the risk of programming errors and liability of designing your own
system. Why reinvent the wheel?

While I experimented with programming Internet shopping carts and payment systems decades
ago, by the time I was ready to start selling e-books, it was much easier to use a prepackaged
solution. It was over three years ago when I first set up the ComputorEdge E-Books Web site
(see Figure 1). The site is built upon the e-commerce software from GoDaddy called Quick
Shopping Cart. I now think it foolish for anyone to consider building their own Web shopping
cart unless they have a highly unique situation. The liability for taking credit cards alone is
huge—just ask Target. The problems involved in designing a shopping cart from scratch are
many—just ask the government.
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Figure 1. The ComputorEdge E-Books Web site is a package shopping cart service from GoDaddy.

I'm not necessarily recommending GoDaddy's Quick Shopping Cart over any of the other
available e-commerce services. It has worked for me, but there could easily be much better
systems for other types of business. The most recommended package I've seen in reviews is
BigCommerce as explained in this e-commerce Blog. While Shopify is often highly ranked, the
fact that they took a percentage (as high as 2%) of every sale was previously a problem. It
now looks like competition has forced Shopify to drop its transaction fee.

It's worthwhile to investigate the shopping cart options available before committing to one
system. Most offer a free trial, but if you're only testing, don't overdo it before you make your
decision. It can be a lot of work to post and maintain your products regardless of the software.
During a free trial, do just enough to evaluate how easy it is to add and update products. Any
Web shopping cart package should give you a way to display your product catalogue and make
secure purchasing transactions easy and safe.

I use the ComputorEdge E-Books site as an example because that's what we're using and it
has all the basic features needed. I originally started with GoDaddy because it was one of the
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systems that would readily hook up to Intuit's Payment System, the credit card processing
system we use. The list of Intuit supported e-commerce systems is much longer now including
virtually all of the most recommended shopping carts. Quick Shopping Cart also supports
digital downloads (e-books or software) as products—which is my one mandatory
requirement. The price was low enough that I saw little risk in signing up. ComputorEdge E-
Books operates as a separate site from ComputorEdge.com displaying the e-book catalogue
and offering a secure payment system.

A Separate Web Site

A Web shopping cart does not need to be part of another Web site. In fact, it can easily be
your entire site. If your primary purpose is to display your products and engage in financial
transactions, then you may want to make a Web shopping cart your main site.

Admittedly, outside of setting up catalogues and taking money, most shopping cart software is
pretty limited as an independent Web site. This type of package is designed for displaying a
catalogue of goods and making it easy for customers to buy. For example, if you wanted to
add pages of explanation or articles on pertinent topics, the Quick Shopping Cart won't handle
it very well. That's why it's useful to maintain a separate Web site or Blog. But, if you just
need to display a catalogue in an organized fashion, then the shopping cart will do the job.

If you do have an active Web site or Blog, then you don't need to make any changes to it
(other than adding links to the shopping cart system) to accommodate selling products. Web
shopping carts do operate as a separate site—even if embedded in the primary site. This is
because the one of most important parts of e-commerce is the financial transaction which
completes the sale. This transaction requires a secure encrypted site with direct interaction
through the payment gateway which processes credit cards, PayPal, and other forms of
payment. It is much easier to let experts, who have been doing it almost since the beginning,
take responsibility for collecting the money. By setting up the shopping cart catalogue/payment
processor as a separate site hosted by the service provider, your liability for sensitive data is
limited. Here at ComputorEdge we never even see the credit card numbers put into the
payment page at ComputorEdge E-Books.

Encrypted sensitive data moves directly from the secure Quick Shopping Cart page to Intuit
Merchant Services which processes the credit card transactions. None of the shopping process
ever occurs on ComputorEdge servers. The beauty of this type of system is that you don't
even need a separate Web site to open up for business. If you just want a place to advertise
and sell your 3D printer products, the shopping cart can be your entire Web site.

Shopping Cart Style Templates

A good shopping cart package will offer storefront templates for tailoring to your products (see
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Figure 2). A storefront template is a Web page design for the catalogue pages. There are tools
included for changing colors and other minor changes, but once you choose a template, the
look and feel of your catalogue is set. All you need to do is add your product categories and
the products.
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Figure 2. Templates Web site is a package shopping cart service from GoDaddy.

You can usually change a template later without any loss, but I would advise against this. If
people have grown accustomed to the look and feel of your site, changing it will only freak
them out. They may fear that it's not the right site—especially if they enter credit card
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information. Fear of unfamiliar Web sites is not a small problem for a Web business. Some
people won't use Amazon because of this concern about scam sites. You can imagine how
they feel about the small independent sites. Ultimately, you must address this buyer's concern,
but that's a topic for another time.

Shopping Cart Categories

If you only offer one or two products, then you may not need to use categories, but in most
cases you use categories to make it easier for customers to find the right product. (Figure 1
shows a dropdown menu generated from the categories.) For example, ComputorEdge E-
Books has a number of subcategories under AutoHotkey E-Books (see Figure 3)—possibly
too many. However, the different book formats make it important to offer the products in
ways that are easier for the shopper.
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Figure 3. Categories can have subcategories for filtering the buying decision.

All of the major categories appear in the top menu bar on each page of the shopping cart site
as shown in Figure 1.

12



July 11, 2014 Shopping Cart Products

Shopping Cart Products

Each product is entered as a separate item with numerous options which include pricing, name,
description, sales prices, images, etc. (see Figure 4). There are WYSIWYG (What You See Is
What You Get) editors for picking type style and colors. This is standard for most shopping
cart software. You don't need to know HTML to work with the pages—but it helps.
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Figure 4. Each product with product information is added separately.

If you know a little HTML code, then you will find it easier when the WYSIWYG program
starts generating excess code. (I've never seen an HTML generator which didn't occasionally
insert too much code—especially if you're making a lot of text style changes.) These user-
friendly page generating systems usually work pretty well, but every once in a while it's useful
to be able to switch to the HTML mode and clean things up.

The products in our shopping cart program are defined separately from the categories. That
means they can be assigned to multiple categories or easily moved from one category to
another. I assume that this is true for most shopping cart software. It would be pretty limiting
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if a product was always tied to a specific category.

When a category is selected by the customer, abbreviated listings of all the products in the
category are shown on that page (see Figure 5). In this case, the three different formats of the
free AutoHotkey book are shown.
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Figure 5. Category page shows an abbreviated listing of each product. The three "Also see" options were added with
the footer feature of the category editor.
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For more detailed product information the customer clicks on the product title or the book
cover image. The product page opens (see Figure 6). This is the page that makes the sale (or
not). There is no limit on how much you can say about each item. Take advantage of it. As
I've pointed out previously, buyers like to read the details.
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into AutoHotkey  Applications (EPUB
(EPUB and PDF and POF Bundie)
Bundls) £12.00
5£8.99
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Figure 6. The product page offers detailed information about the item.

The ComputorEdge E-Book's shopping cart software allows each product to link to special
values and other similar product.

Shopping Cart Payment Systems

Depending upon how you process payments, you usually have the option of signing up for the
host's system or a merchant account you already own. Various options are available (see
Figure 7). Fees for processing credit cards or PayPal are separate charges from the cost of the
shopping cart site itself. These charges by the processor usually include a monthly fee, a per
transaction charge (30¢), and a percentage of the sale (often 2% to 3%).

© Ogperations: Payment Options

& £.dd page as Favoerite

¢ Credit Card (Recommended)

b

s X

Let customers use their credit cards to make purchases on vour site.

~  PayPal
Chﬂ out mpaf i

Let customers check out on yvour site using PayPal.

/™ Cash On Delivery (COD)

"\_q_/ Let customers pay (cash, money order, or check) when the product is delivered

— Print and Call \
@ s X

Let customers place an order, print receipt, and call you with payment info.

Copyright ® 2005-2014. All rights reserved.

Figure 7. Payment options in a shopping cart.

For an additional fee, I could set up PayPal as an additional payment option. For some
businesses this may be ideal, but I've seen little demand for PayPal. Most people who would
want to buy my books have credit cards available.
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Additional Set Up Features

I set up the Print and Call method only for the free books so people wouldn't be required to

enter credit card information to get them. The only problem with that method is people don't
receive the download e-mail for a free book until the order is processed manually. (Manually
means someone must click a button.)

It's a good idea to shop around for a credit card merchant account. The fees can vary widely

depending upon the amount of a sale and the volume of transactions.

Additional Set Up Features

To get a feeling for the scope of the set up options the Quick Shopping Cart software a look at
the dropdown menu (Figure 8) gives a pretty good overview.

o

Home SetUp{b Manage

Design

Templates

Template Images
Mobile Storefront
Facebook Page
Store Header

Store Footer

Stare Mavigation
Sidebar

Product Fage Styles
Category Page Styles
Invaice

Colors & Fonts
Media Gallery
Default Product Images
Saved Skins
Advanced C33

FPromaote Report

Business Information

Mame, Logo, Contact Info

Stare Seftings

Store Home Page
Store Preferences
About Us Message
Contact Us Message
Terms & Conditions

Cperations

Payment Options
Stare Payment Rules
Taxes

Shipping

Stare Shipping Rules
Email Motices

Email Templates

Favo

ES

Figure 8. Set up features available in GoDaddy's Quick Shopping Cart.

I'm guessing that most other shopping carts systems have similar capabilities. You don't need
to be a programmer to work with shopping carts. Most features are just a matter of picking

options and entering text.

Management Features

For the day-to-day operations, the Manage menu shows the options for both setting up the
catalogue and products, plus the tools for processing orders (see Figure 9).
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Management Features

Home Set Lp Manage {tn} Promuote Report Favarites Hel
Catalog Orders
- Operat Categories Manage Orders
Add Category Qpen Orders
Products Add Order
Add Product Address Labels
Store Product Display  T-Hub Integration
I | Cre options QuickBooks Integration
"\'__ -_'_,f' VIS Aftributes Fraud Management
- Manufacturers Fraud Blacklist
Letc Warehouses
Reviews Members
= Media Gallery Search Members
( ﬂ\", Pay Inventory Add Member
e = Updates & Exports Manage Roles
Automatic RES Feeds
i Custom RSS Feeds
Lete

Figure 9. Management features available in GoDaddy's Quick Shopping Cart.

While there may be other desirable features, this program does everything I need for now. My
goal is to have more sales on ComputorEdge E-Books than on Amazon. We're getting close,
but that is not a function of the shopping cart.

The problem is that putting up a shopping cart with products is not enough. While the services
will help some with placement on Web searches (a topic for another time), it's up to you to
find ways to get attention.

One of the big problems is people are wary of small online e-commerce sites. They get antsy
when they need to give out names, addresses, credit card numbers, and e-mail addresses to
someone they don't know—and, with the number of scams on the Internet, they should be
nervous. This is not easy for the e-tailer to resolve. The only answer is to build a good
reputation—at least in your market. But that takes time and effort.

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor(@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.
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ComputorEdge E-books offering is his AutoHotkey Applications, an idea-generating
intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8.
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software

Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are. What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction. Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,

Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7

Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7

and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Yol One llore A Cool Little
REFSONIOYUSE App for

Inputting
Common
Phrases

“PhraseOMatic for When Hotstrings and Hotkeys Just Aren't Good Enough” by Jack

Dunning
PhraseOMatic is an AutoHotkey script that makes it easier to enter key phrases into any document or
text editing field for work and personal use. No more memorizing hotstrings or hotkey combinations.

One of the problems with using AutoHotkey hotstring replacements and/or hotkeys for
common phrases, titles, and e-mail addresses is it's difficult to remember them all. That's why
I try to come up with standard ways to activate certain hotstrings making them easier to
remember. For example, I'll use an asterisk at the end of a hotstring to turn a word into a
symbol (as shown in this AutoHotkey column and Chapter four of the free AutoHotkey e-
book, AutoHotkey Tricks You QOught To Do With Windows). The typed word "cent"
immediately becomes the ¢ character when I add the * (cent*). The word "pound" becomes £
when the * is added (pound*). However, there are times when there is just no easy way to
remember certain types of phrases. There are just too many. That's when it's time for
PhraseOMatic.

(New to AutoHotkey? See our Introduction to AutoHotkey!)

PhraseOMatic is an AutoHotkey script written by Douglas Abernathy which puts all of your
important phrases into a pop-up menu. (Douglas can be reached at douglasa@wans.net if you
have any questions about PhraseOMatic or unreasonable demands for new features.) To insert
one of your key phrases into any document or Web editing field, you hit the hotkey (in this
case F6) and pick the one you want (see Figure 1). That phrase is automatically inserted into
the document or editing field at the the cursor's location. It's remarkably easy and intuitive.
Naturally, it does need a little set up for your specific phrases. PhraseOMatic is so cool that
I'm adding the app to my active AutoHotkey scripts.
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A Cool Little App for Inputting Common Phrases

= = B T T 3
| Unfitled - Notepad = [ET |
File ‘Edit Format View Help
Four score and seven years ago
oklahoma §tate university
|
*-= Select Rhrase to Insert from the file PhraseOMatic.ba =-
Universities k The Wrmuesity of Arizona
Oklaho a State University

Four score and seven years ago
Ask ry can do for you

Once upon a time

Titles 3

Mississippi State University
Ohio State University

Figure 1. Press F6 then pick the phrase you need from the pop-up menu. It's inserted into the text.

[ originally started working with an older version of the script. Douglas has since sent me
the current version (now posted at the ComputorEdge AutoHotkey download site ) which has
a number of enhancements. These initial comments apply equally to either version.

While you don't need to do anything with the AHK file which runs the app, there is a text file
which holds the phrases. This file initially called PhraseOMatic.txt can be edited with Notepad
or any other text editor, but a right-click on the PhraseOMatic icon in the System Tray offers
an Edit Phrases option which will open the file with your default text editor. The phrase file
uses simple formatting, but does require you to understand a tiny amount of special coding
(see Figure 2). The first few lines of the data file (PhraseOMatic.txt) are header information
which does not need to be changed. The header information may look slightly different in the
newer version of PhraseOMatic, but it serves the same purpose.

22


http://www.dropbox.com/sh/4qu48lyqtixdg7t/QdMY1dNuy7

July 11, 2014 A Cool Little App for Inputting Common Phrases

MenuTitle:*-= Select Phrase to Insert trom the Tile PhraseOMatic. Tt =-%
ToolTip:Phraseomatic (F6)

shel132.d11 Icon:47

Certain first characters on a line have special meaning:

/ Ends a submenu Block

- Inserts a Separator Line

; Comment (non-displaying)
> Comment (displays but 30&5 nothing it clicked)
<———— Add / Edit Text Items Below This Line —————>
[Universities]

The University of Arizona

oklahoma state University

Harvard University

Mississippi State University

ohio state University

/ Comment at the end of a submenu block

; Comment on a line by itself

Four score and seven years ago
Ask not what your country can do for you [ |ndividual Lines
once upon a time

[Titles]

> Company Titles

Chief Executive officer (CEQ)
vice-President of Legal affairs
Vice-President of Finance

Director of Research and Engineering
Director of Marketing

[Jack's Phrases]
you lookin' at me?
what's it to you? e S MU [tems
First and ten! Do it again!
we have to talk.

IT wasn't me!

I don't get it.

Figure 2. Phrases can either be added to the PhraseOMatic.ahk file as individual lines or as submenus by using the
square brackets ([...]).

If you enter a plain line of text on an individual line, it will appear in the top level menu as a
phrase option. But if you only used this method of adding phrases, you can see how the list
might become too long. To shorten (and organize the list) submenus with additional phrases
can be added. This is done my enclosing a menu header in square brackets (i.e. [Jack's
Phrases]), adding the phrases, then terminating the submenu with a forward slash (/), as
shown above in Figure 2.

Note that at the top of the file there is a list of the special characters used to modify how the
pop-up menu will look. (There is an additional character (@) in the current version of
PhraseOMatic which allows extra long phases to be condensed to a short menu item.)

After adding the submenu of Jack's Phrases to the text file and reloading the script, the new set
of phrases appears in the menu (see Figure 3). (If you use the Edit option in the right-click
menu for the PhraseOMatic icon in the System Tray, then save any changes and quit the text
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editor, PhraseOMatic will automatically update.)

""" Untitled - Notepad =@ =

| File Edit Format View Help

|Four score and seven years ago

|
|oklahoma state university

We have to talk.

Universities

Four score and seven years ago
Ask not what your country can do fory
Cnce upon a time

Titles

You lookin' at me?

Wha’c[':}if: to you?
First and ten! Do it again!
We have to talk.

" It wasn't me!

Idon't getit,

Jack's Phrases

Figure 3. A new submenu is added to PhraseOMatic after the PhraseOMatic.txt file is edited.

It's easy to see how the menus—even when using submenus—can still get quite long. To deal
with this problem, the latest version of PhraseOMatic allows you to keep and use multiple
phrase files which are selected through the right-click menu in the System Tray. Plus, the
phrase shortening technique (@) mentioned above helps to prevent bloated menus.

Changing the Hotkey

For me using F6 as a hotkey interferes with one of my most used AutoHotkey line formatting
hotkeys. I was planning to change the hotkey in any case, but another observation that I've
made about pop-up menus is that it's a little awkward to access the keyboard each time you
need the menu. I prefer to open the menu with the mouse (especially when I have extra mouse
buttons), then select an item with that same mouse—no keyboard needed. This saves me the
effort of reaching over the keyboard to hit F6. (Admittedly, this may seem pretty silly, but, if
possible, I like to open menus with mouse clicks.) The line of code that assigns the hotkey is:

~Fo::

Menu, PhraseMenu, Show
Return
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Since there is only one command in the assignment, it can be shortened to one line:
~F6:: Menu, PhraseMenu, Show

There are two ways to use extra mouse keys (usually located on opposite sides of the mouse).
The first is to use the xbuttonl and xbutton? assignments. Since I've already used the xbuttonl
with my QuickLinks script (discussed in a previous AutoHotkey column and Chapter Twenty
in the Digging Deeper Into AutoHotkey e-book, plus notes on using xbuttonl in this column), |
opted to use my last remaining button, xbutton2:

xXbutton2: :Menu, PhraseMenu, Show

This worked fine for the mouse on the Windows 7 computer, but wasn't recognized by the
mouse on the Windows 8 laptop. I could have gone through some gymnastics trying to figure
out the name assignement for the mouse button, but I found it easier to use the utility software
which came with the mouse to assign a hotkey directly to the button. I used ALT+P which
didn't seem to interfere with anything else. Since the mouse button now sends ALT+P, I was
able to use the following line to activate the PhraseOMatic menu:

!'p::Menu, PhraseMenu, Show

You can add as many of these types of code lines as you like without any interference with the
script. It merely activates a new hotkey combination for each line. You may find it necessary
if you are using the same script on multiple computers with different mice.

(If you want to learn about using AutoHotkey scripts, see "Installing AutoHotkev and Writing
Your First Script)

Now I can use the extra buttons on a mouse to pop up the QuickLinks menu with the fourth
button and PhraseOMatic with the fifth button. Of course you do need at least one keyboard
combination for those computers with a plain vanilla mouse (no extra buttons). (These lines of
code have not been added to the posted script. You must do it yourself.)

The Latest Version of PhraseOMatic

The first notable new feature added by Douglas to the current version of PhraseOMatic is the
ability to create, use, and switch to different phrase files. This is a great help when you have
different phrases for different purposes. By keeping them in independent text files, the pop-up
menu is prevented from becoming unwieldy. The second is the addition of a macro character
(@) which allows you to shorten huge phases into relatively short items on the menu. It is
worthwhile to read the Readme. txt file since it gives a number of instructions on how these
features work. (I did not encounter the Web page bug mentioned in the Readme.txt file. It
worked fine for me, but the added Saving to Clipboard feature could be useful in a number of
situations.)
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When you first activate the current version of PhraseOMatic (F6), the standard menu will
open (see Figure 4). This menu offers basic instructions for getting started.

{Click} or {Enter} inserts, with {Shift} -> clipboard
PhraseQMatic Sample File
This file appears when you run PhraseOMatic
for the first time and have not yet defined any
Phrase Files (text files with a .t extension).
Right-click the PhraseOMatic tray icon and select
Create Phrasefile... if you want to start a new file
or Add... if you have an existing file you wish to
lead into your copy of PhraseQMatic,
Be sure to read the Readme.tut file!
United States of America
Declaration of Independence

Restaurants 4

Titles 3

Figure 4. The default phrase file is loaded providing basic instructions when the script runs the first time.

When you right-click on the PhraseOMatic icon in the system tray, a menu opens with all the
options you need to create, use, and modify your phrase files (see Figure 5). Selecting the

active phrase file is as simple as clicking one from the list. (The active file is shown with a
check mark.)
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Open

Help

Window Spy
Reload This Script
Edit This Script

Suspend Hotkeys
Pause Script
Exit

Create File...

Add File...

Mew PhraseFile
Aero

Added PhraseFile

Create Shortcut in Startup Folder
Edit Phrases
Path: C:\Users\Jack\Box Syncheditorialh3228

v R
ENG  Wednesday

ed ) W O M &g (B2 40 ) O 77972014

Figure 5. The PhraseOMatic right-click menu has all the functions needed to Create, Add, and Remove phrases
files. The current available phrases files are circled in red.

There is even a Create Shortcut in Startup Folder option for automatic loading every time you
log in.

The PhraseOMatic Script

Working on the code in the PhraseOMatic script is not for a beginner. Other than changing the
hotkey combinations, I would resist the urge to tinker with it. From my perspective, the most
important learning point from Douglas' work is his use of the Window Registry to save
information about the multiple phrase files. By using the Registry for this setup information,
there is no need for a separate file to save the data. Many people might have used an INI file
structure to do the same thing, but that would have required the extra file on the computer.

If someone is looking for a way to take advantage of the Windows Registry to support an
AutoHotkey script, then studying the PhraseOMatic script would be worthwhile. (I may even
explore this myself in a future column.) I've only glanced over it, but it looks like there are a
number of useful techniques involved. It's a clever way to hide and use data that changes from
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time to time.

The PhraseOMatic script is posted at the ComputorEdge AutoHotkey download site in the file
PhraseOMatic.zip. It includes the script, PhraseOMatic.ahk, the default phrase file,
PhraseOMatic.txt, an extra sample phrase file, aerospace.txt, the Readme.txt file, and a
compiled version, PhraseOMatic.exe, for people who want to run the app without needing
AutoHotkey installed on their Windows computer. (I compiled PhraseOMatic.exe myself, so
you know it's safe—well, I know it's safe.)

% * *

Just released! AutoHotkey Tricks You Ought To Do With Windows! This e-book includes
both those tips and the reference material (Table of Contents and indexes) from the other
three AutoHotkey books. Pick up a copy free and share it with your friends.

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor(@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.

ComputorEdge E-books offering is his AutoHotkey Applications, an idea-generating
intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"”

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are. What They Do, and How to Get Started!.
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Misunderstanding Windows 8: An Introduction. Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,

Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7

Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7

and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Wally Wang's Apple Farm

“The Coming iWatch” by Wally Wang

Wa g's
Apple Farm

The Coming iWatch; Bring Your Own Device; Unique (and Horrible) User Interfaces, Function Keys.

Apple recently hired the sales director of luxury Swiss watch maker TAG Heuer. Why would
Apple need a sales director who has experience selling luxury watches? Most likely because
Apple plans on making their rumored iWatch both a health item and a fashion accessory.

Apple has been hiring dozens of medical sensor experts along with releasing their HealthKit
software development kit, so it's clear that a wearable computer is coming soon. It's also clear
that Apple intends this iWatch to target people interested in monitoring their health while also
making a fashion statement by wearing an iWatch at the same time.

Remember how distinctive people looked wearing white ear buds while listening to an iPod?
Or making phone calls with an iPhone? If people are going to strap a wearable computer to
their arm, they'll likely want it to look good so they can feel better about themselves at the
same time.

The idea of a product making people feel good may seem shallow, yet people do this all the
time from the clothes they wear to the car they drive. Windows enthusiasts often do this in a
perverse manner by boasting on how little they paid for their PCs and how they don't care
about product appearance but functionality instead, which is still a fashion statement of a
different kind altogether.

The real key to the iWatch won't be its appearance but its functionality. The iWatch has to do
something that current technology can't do. Then it also has to look good to make people want
to buy and wear one. Remember, people always buy on emotions and rationalize their
purchase later. Even Windows enthusiasts do this by buying the least expensive PC possible
and then rationalizing that they got a bargain even if they're frustrated using it because it's too
slow, too hard to use, and too cumbersome. The iWatch won't succeed because of its
appearance, but because it solves problems that current technology can't solve today.

Former Apple founder Steve Wozniak tends to buy and play around with different gadgets of
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all kinds just to play with them. Despite his love of gadgets, Steve Wozniak gave up on
Samsung's Galaxy Gear wearable computer because "That was the only technology 1 bought
to experiment with that I threw out after half a day, sold it on eBay because it was so
worthless and did so little that was convenient."

The problem with the Samsung Galaxy Gear wearable computer is that it simply mimics a
smartphone but isn't as easy or convenient to use. When something isn't convenient to use,
why bother using it, let alone buying and keeping it?

Look at today's wearable computers like the Samsung Galaxy Gear smartwatch and you can
see a product that solves nothing new but makes current tasks harder to do. (Think of
Windows 8 as another product that makes current tasks harder to do while solving nothing
new.) Now wait until Apple releases the iWatch to suddenly see everyone magically
understand what a smartwatch should do while claiming the iWatch lacks innovative features
because it doesn't exactly duplicate existing technology like the Samsung Galaxy Gear
smartwatch does.

When the iWatch arrives later this year, be ready for another revolution in the computer
market. Then watch the fun to see if Microsoft will try cramming the Windows 8 tile interface
into the tiny screen of a smartwatch to fulfill their dream of using the same operating system
and user interface in different form factors whether it works for people or not. (For a preview
of this insanity, just try using the tile interface of Windows 8 on an ordinary PC without a
touchscreen and see how long you enjoy using technology that makes current tasks harder
while failing to let you solve anything you couldn't do before.)

Bring Your Own Device

For the longest time, companies dictated exactly what technology their workers could use.
They didn't focus on what was best for their workers, but what was easiest and cheapest to
buy and manage. That's like giving people pencils because it's cheap and easy to maintain
rather than buying them computers that are much more expensive.

Fortunately workers have decided they know what type of technology they want to use.
VMware recently surveyed 376 IT professionals and asked them to give three reasons why
their organization supported the Macintosh. The top three answers were:

* User preference
* Macintosh specific applications
* Less maintenance
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If your organization is officially or unofficially supporting Macs, please
l select up to 3 reasons why. |
N

User preference | — — s—E
Applications that only run on Mags [ — 40%
Less maintenance |—— 24%
Executive mandate 'h—i 22%
Security advantages _ 1%
Other | 16%
Idon't know jed 4

0% 10% 20% 30% 40% OS0% 60% 70% B0%

Figure 1. The top reasons why companies support the Macintosh.

While a survey of 376 people is hardly statistically relevant, it does highlight the fact that not
everyone in the world believes that Windows is superior and always will be. Why is user
preference the number one reason companies support the Macintosh? If users have a choice
between a Windows PC or a Macintosh, what would make them prefer the Macintosh instead
of learning the tile interface of Windows 8 that takes more steps to accomplish the simplest
tasks while being harder and less intuitive to use?

In the old days, people chose Windows because they needed to use Windows specific
applications. If people are now choosing the Macintosh because of Macintosh specific
applications, that must mean that Windows no longer has the largest software library on the
planet. Given the fact that you can run every Windows programs on a Macintosh using a
virtual machine program like VMware's Fusion, a Macintosh is actually more versatile than a
Windows PC.

The third reason focusing on less maintenance of the Macintosh most likely highlights the fact
that a Macintosh doesn't need to worry about disk fragmentation or Windows registry errors
that can slow down a Windows PC over time. Of course if you simply deny the fact that a
Windows PC needs constant disk defragmentation or registry cleaning to prevent a PC from
slowing down over time, you can delude yourself that a Windows PC actually requires less
maintenance than a Macintosh. Naturally clinging to a delusion isn't the same as dealing with
reality, but that doesn't stop many people from angrily denying facts in favor of holding on to
their fantasies anyway.

What actually matters more is that people accomplish useful work regardless of what
technology they use. The technology they use can help them achieve results faster or simply
get in their way and slow them down.

For many Windows enthusiasts, learning anything new will slow them down, so they can
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justifiably say that a Windows PC is more efficient, but only for them. Of course, for many
Windows users, Windows 8 forces them to learn something entirely new, which slows them
down while the familiar pull-down menus of the Macintosh actually makes the switch from a
Windows XP/Vista/7 PC to a Macintosh easier than switching to Windows 8. The fact that the
most popular add-ons for Windows 8 make Windows 8 look and act more like Windows 7
tells you how popular the Windows 8 tile interface is among even hard core Windows
enthusiasts.

Whatever company you're in, use the technology that makes you more efficient regardless of
what other people think. Just remember that new technology is useless if it makes your current
tasks harder to achieve, and that clinging to old technology may mean being less efficient than
your competitors just because they're using something better while you refuse to learn
anything new at all.

Unique (and Horrible) User Interfaces

How do you create a user interface optimized for the smaller size of a smartphone screen? If
you're Microsoft, you can try recreating the Start menu user interface of Windows XP on
smartphones and call it Windows Mobile. When that doesn't work, you can recreate the
smartphone user interface of Windows Phone and apply it to desktop PCs for Windows 8 and
then act surprised when that doesn't work either.

Rather than try to cram one user interface into every possible computing device, it's best to
optimize the user interface for each device. On the iPhone, there's a unique weather app called
WeatherCube that takes advantage of the small iPhone screen.

The traditional way of displaying data on an iPhone screen involves swiping screens to the side
to see the next one. Of course, this is kind of boring, so WeatherCube lets you spin and rotate
the screen around like manipulating a cube. This exploit the touch gesture feature of the
smaller iPhone screen while also making the app more fun and engaging to use.
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Figure 2. WeatherCube displays a 3-D user interface based on a cube.

By spinning the cube around, you can see the weather for different days. By spinning just part
of the user interface around, you can check the weather for different cities or view settings for
customizing the app.

The best user interfaces make using the program playful and engaging to encourage you to
have fun while rewarding you with visual feedback. The worst user interfaces get in your way,
hide necessary commands, and aren't fun or interesting to use.

In the book Visual Usability, author Tania Schlatter outlines three principles of a good user
interface:

* Consistency
* Hierarchy
* Personality

Consistency means the user interface is predictable. Look at Word 2011 for the Macintosh and
when you click the File menu and choose Open, the Open dialog box appears right over your
currently open document. Click on the View menu and a pull-down menu appears over your
currently open document. No matter which pull-down menu you choose, Word 2011 for the
Mac works the same. That's consistency.

Now look at Word 2013 for Windows. When you click on any tab such as the Home or Insert
tabs, a new ribbon of icons appears. But if you click the File tab, suddenly your current
document disappears from view and an entirely new screen appears, hiding your currently
open document completely out of sight. That's inconsistency.
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Why should clicking eight out of nine tabs behave one way but the ninth tab behaves an
entirely different way for no apparent reason?

Hierarchy means it's easy for the user to understand how to get from one point to another.
Click a title on the menu bar (such as File or Edit) and you always get a pull-down menu in
Word 2011 for the Mac. Click a menu command and Word 2011 either does something or
displays a dialog box. At all times you can clearly see where you are and how to go backwards
or forwards.

In Word 2013 for Windows, click the Insert tab and click the Text Box icon to draw a text box
in your document. Because your text box is now selected, Word 2013 suddenly displays a
Drawing Tools Format tab that only appears when the text box is selected. Click away from
this text box and this Drawing Tools Format tab disappears.

While this should be simple to understand, novices often get puzzled why a Drawing Tools
Format tab should disappear with no clue for how to make it appear again. That disrupts the
hierarchy because it's not immediately clear how one action (selecting a text box) leads to
another action (displaying the Drawing Tools Format tab).

For extra fun in Word 2013, click the File tab, choose Save As, click the Computer icon, click
the Browse icon (four steps total to open the Save As dialog box that Word 2010 for Windows
could do in two steps) to view the Save As dialog box.

In the Save as type list box, choose Word 97-2003 Document to save your document in the
older .doc file format and click the Save button. A Microsoft Word Compatibility Checker
dialog box appears to let you know that the features of something as simple as a text box may
not be supported in the older file format.

Wicrosoft Word Compatibility Checker ?

The following features in this document are not supparted by earlier
wersions of Word, These features may be lost or degraded when you

ﬁ save this document in an earlier file format, Click Continue to sawve
the document, To keep all of your features, click Cancel, and then
save the file in one of the new file formats.

summary OCCUrrences
Shapes: and texthoxes will be converted to effects available in 1
this format.

Check compatibility when saving documents

[ Continue Cancel
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Figure 3. Word 2013 for Windows doesn't treat text boxes the same when saved in the older Word 97-2003 .doc file
format.

Click the Continue button. Now click on the text box in your document and you'll notice that
Word 2013 no longer displays the Drawing Tools Format tab but has renamed it the Text Box
Tools Format tab. Why does the user interface change simply because the file format of the
document has changed?

Figure 4. When a file is saved in the .docx format, Word 2013 displays a Drawing Tools Format tab for modifying
text boxes.

Figure 5. When a file is saved in the .doc format, Word 2013 displays a Text Box Tools Format tab for modifying the
exact same text box.

Imagine working with text boxes on a document in Word 2013 and suddenly saving it in the
older .doc file format so it's compatible with someone using an older version of Word. Now
when you try to edit your text box, you'll see an entirely different user interface with no clue
as to why this change happened or how to get back to the Drawing Tools Format tab and
away from the Text Box Tools Format tab. That's a clear demonstration how breaking the
hierarchy of a user interface simply confuses users.

The third principle of user interface design revolves around personality, which is a more
subjective criterion. At the very least, a user interface should stay out of the way so the user
can directly manipulate the data he or she wants. WeatherCube does this by letting users flip
the user interface around to view different types of data. The personality of WeatherCube is
one centered on fun and exploration with clear paths for how to return back to a previous
screen.

Can you guess how well Windows 8 and Word 2013 fare in the subjective personality
measurement test? If your mouse has a scroll wheel, scroll it up and down to see the Windows
8 tiles slide left and right instead of up and down like you would expect when you scroll the
mouse wheel up and down.

For decades, Microsoft has trained people to look for the Exit command under the File menu.
In Word 2007/2010 you could click the File tab and click Exit to exit out of the program. In
Word 2013, click the File tab and the Exit command is nowhere to be found. To exit out of
Word 2013, you have to click on the close button in the upper right corner of the Word
window.
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Why remove the Exit command from the File tab in Word 2013 especially since that's the first
place everyone's going to look for it after decades of using Microsoft Word? That's just one of
many examples of how Word 2013 shatters the expectations of users and expects them to
relearn basic commands just to do the simplest tasks.

Rather than make tasks easy to accomplish and predictable in its behavior, Windows 8 and
Word 2013 act like a sadistic, schizophrenic clown intent on frustrating and confusing you at
every possible moment.

User interfaces should make tasks easier to accomplish than before, not harder. If a user
interface makes tasks harder and more confusing to accomplish, it doesn't matter if the
company making that product is Microsoft, Apple, Google, or anyone else on the planet. Bad
user interfaces create horrible software that no amount of denying can ignore, but you can bet
people will try anyway just so they can cling to their fantasies that one company is always
perfect while a rival company is always wrong.

k *k *

Hardly any programs use function keys any more, yet function keys still linger on keyboards
anyway. To make function keys useful, most keyboards treat them as hardware controls for
adjusting screen brightness or audio volume.

If you're one of the handful of people still using function keys, you can make function keys
behave like function keys by clicking the Apple menu and choosing System Preferences. Then
click the Keyboard icon and select the "Use all F1, F2, etc. keys as standard function keys."

As an alternative, look for the Fn key on your keyboard that you may need to hold down
before pressing a function key. The Fn key tells your Macintosh to treat function keys like
function keys instead of hardware controls.
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8006 Keyboard
| «|» || Showal | (Q )

Text | Shortcuts  Input Sources ]

Key Repeat Delay Until Repeat

\/ T

Off Slow Fast Long Short

[ I Use all F1, F2, etc. keys as standard function keys

When this option is selected, press the Fn key to use the special
features printed on each key.

™ Show Keyboard & Character Viewers in menu bar

| Change Keyboard Type... | | Set Up Bluetooth Keyboard... | | Modifier Keys... |

Keyboard battery level: @1 21% ()

Figure 6. You can make function keys actually work like function keys.

In the early days, before Wally became an Internationally renowned comedian, computer
book writer, and generally cool guy, Wally Wang used to hang around The Byte Buyer
dangling participles with Jack Dunning and go to the gym to pump iron with Dan Gookin.

Wally is responsible for the following books:

Microsoft Office 2013 For Dummies

Beginning Programming for Dummies

Beginning Programming All-in-One Reference for Dummies

Breaking Into Acting for Dummies with Larry Garrison

Strategic Entrepreneurism with Jon and Gerald Fisher
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How to Live with a Cat (When You Really Don't Want To)

The Secrets of the Wall Street Stock Traders

Mac Programming For Absolute Beginners

Republican Fairy Tales (Children's Stories the 1% Tell About the Rest of Us)

The Zen of Effortless Selling with Moe Abdou

The 15-Minute Movie Method

Erotophobia (A novel)

Math for the Zombie Apocalypse

How to Write a Great Script with Final Draft 9

How to Write a Great Script with Fade In

The Elements of a Great Script: Star Wars

The Elements of a Great Script: Die Hard

The Element of a Great Script: Back to the Future

The Elements of a Great Script: Rocky

The Elements of a Great Script: It's a Wonderful Life

In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15
Minute Movie Method," finding interesting news stories about cats at his site "Cat Daily
News," giving advice to authors who want to self-publish e-books at his site "The Electronic
Author," and providing the type of advice he wishes someone would have told him when he
was much younger at his personal Web site. Wally can be reached at
wally@computoredge.com or you can follow him on Twitter (@wallacewang _com.
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Editor's Letters: Tips and
LETTERS Thoughts from Readers

“Computer and Internet tips, plus comments on the
articles and columns.” by ComputorEdge Staff

"Never Using Sleep/Hibernate,” "Windows Did Not Shut Down Successfully,” "Microsoft Updates for
XP"

Never Using Sleep/Hibernate

[Regarding the June 20 Digital Dave column:]

Dave, I tend to have older hardware, currently Windows 7 on a P4, 3.0GHz with 4G RAM
and Windows 8.0 on Core 2 Duo 2.0GHz with 4G RAM and single SSD.

I'd agree with you for XP (not sure about Vista), but you might want to give at least the sleep
function for Windows 7 and 8 a try. I don't use hibernate, but sleep both regularly as well as
automatically and have little to no problems waking and having everything work. I'd say 99%
success with Windows 8 and 98% with Windows 7. The Windows 7 machine has been built
and running for several years, lots of programs added, many added and removed, still sleeps
and wakes just fine.

Almost never have to reboot either because of malfunction/waking issue, usually because some
update or other wants a reboot.

So give it a try.

P.S. Took me a /long time to find a shortcut that would do the same sleep function in
Windows 8.0 (8.1 has shortcut at the start button, I understand), but I finally found it, created
a shortcut and pinned it to my taskbar for quick/easy sleep when going out. Here's the
command:

rundll132.exe powrprof.dll, SetSuspendState 0,1,0

-Rich Ernst, San Diego

Windows Did Not Shut Down Successfully

[Regarding the June 20 Digital Dave column:]
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I used to get that on one PC frequently. It turned out to be bad power supply! I also had a
motherboard that had a hairline crack (heat sensitive).

-Walter, San Diego, CA

Microsoft Updates for XP

[Regarding the June 20 Editors Letters: Tips and Thoughts from Readers column:]

DD,

As a matter of interest, I have continued to get Malicious Software Removal Tool updates for
my XP machines two months after Microsoft support stopped in April.

-Joe Nuvolini, Colorado Springs, CO

ComputorEdge always wants to hear from you, our readers. If you have specific comments
about one of our articles, please click the "Tell us what you think about this article!" link at
the top or bottom of the specific article/column at ComputorEdge.com. Your comments will
be attached to the column and may appear at a later time in the "Editor's Letters" section.If
you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at
ceeditor(@computoredge.com. If you would like to review our recent e-books, please visit
ComputorEdge E-Books.

Send e-mail to ceeditor@computoredge.com with questions about editorial content.
Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.
Copyright © 1997-2014 The Byte Buyer, Inc.

ComputorEdge Magazine, P.O. Box 83086, San Diego, CA 92138. (858) 484-1998

Click to Visit ComputorEdge™ Online on the Web!
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